Experiment HC-1: Blood Pressure, Peripheral Circulation, and Body Position

Background

When the heart pumps blood into the arteries, there is a sudden increase in pressure in the arteries. The
highest level of pressure, that occurs immediately after the ventricles contract, is known as the systolic
blood pressure. The pressure in the arteries slowly declines as the heart relaxes. The lowest level of
pressure, that occurs just prior to the next contraction of the ventricles, is known as the diastolic blood
pressure.

Systolic and diastolic blood pressures are commonly measured with a stethoscope and a
sphygmomanometer (blood pressure cuff). The cuff is placed on the upper left arm as the stethoscope is
used to listen to the pulsatile flow of blood in the major artery of the arm. Once the stethoscope is
properly placed over the artery and the thumping sound of the pulse is heard, the cuff is inflated. If the
pressure in the cuff is high enough, the cuff compresses the artery in the upper arm and the flow of
blood through the artery to the lower arm stops and the thumping sound disappears. When the pressure
in the cuff is released and the pressure in the artery is greater than the pressure in the cuff, blood
resumes flowing to the lower arm. As the blood resumes flowing into the lower arm, the thumping
sound of the pulse reappears. The pressure in the blood pressure cuff at the time that the thumping
sound first reappears is equal to the systolic blood pressure. When more pressure is released from the
cuff, the thumping sound eventually disappears, again. The pressure in the blood pressure cuff at the
time that the thumping sound disappears is equal to the diastolic blood pressure.

Measuring blood pressure using a blood pressure cuff and a stethoscope takes a great deal of practice.
To assist students in learning the technique of taking blood pressures with a stethoscope, a pulse
plethysmograph will be used to record the appearance and disappearance of pulsatile blood flow in the
artery that indicate when the pressures in the cuff are equal to the systolic and diastolic blood pressures.
In addition to learning to measure the blood pressure and comparing blood pressures from different
subjects, the effects of cuff location, body position, and arm position will be examined.

Warning: As explained above, this procedure involves stopping blood flow to the arm, which is
potentially dangerous. Please take the following precautions.

Precautions
1. Know what you are doing ahead of time.
2. Do not leave the cuff inflated for any prolonged period of time (>20 seconds).
3. The subject should flex and extend their fingers between experiments to maintain blood flow.
4

. This experiment should be performed by healthy individuals who do not have a personal or
family history of cardiovascular or respiratory problems. It is preferable to use more than one
subject during the course of the lab session.
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Experiment HC-1: Blood Pressure, Peripheral Circulation, and Body Position

Equipment Required

PC or Mac Computer

IXTA data acquisition unit
USB cable

IXTA power supply

PT-104 Pulse plethysmograph

Stethoscope

BP-220 Non-invasive blood pressure transducer

BT-220 Black tygone tubing with Luer connectors

IXTA Setup
1. Place the IXTA on the bench, close to the computer.

Check Figure T-1-1 in the Tutorial chapter for the location of the USB port and the power
socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial chapter for a picture of the IXTA power supply.

Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA.

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to
turn on the unit. Confirm that the red power light is on.

Start the Software

1.

Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is
not available, click on the Windows Start menu, move the cursor to All Programs and then to
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window
will appear as the program opens.

On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv4.iwxgrp. Select this group and click

Open.

Pull down the Settings menu again. Select the BloodPressure-BodyPosition-LS2 settings file
from Human Circulation.

After a short time, LabScribe will appear on the computer screen as configured by the
BloodPressure-BodyPosition-LS2 settings.

For your information, the settings used to configure the LabScribe software and the IXTA unit
for this experiment are programmed on the Preferences Dialog window which can be viewed by
selecting Preferences from the Edit menu on the LabScribe Main window.
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7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any
of the following documents:

* Appendix
* Background
* Labs

* Setup (opens automatically)

Blood Pressure and Pulse Transducers Setup

1. Locate the BP-220 non-invasive blood pressure (NIBP) transducer (Figure HC-1-S1), and PT-
104 pulse plethysmograph (Figure HC-1-S2), in the iWorx kit.

Figure HC-1-S1: The BP-220 non-invasive blood pressure transducer.

2. Plug the DINS connector of the PT-104 into the Channel A5 input (Figure HC-1-S3).
3. Plug the tubing connector of the BP-220 into the channel labeled A2 on the front of the IXTA.
4. Calibrate the BP-220 and then put it aside until it is needed in Exercise 1.
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Figure HC-1-S2: The PT-104 pulse plethysmograph.
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Figure HC-1-S3: The PT-104 pulse transducer and the BP-220 non-invasive blood pressure transducer
connected to an IXTA.

Calibration of the Non-Invasive Blood Pressure Transducer

Procedure
1. Lay the cuff of the BP-220 on the lab table.

2. Click on the Record button, located on the upper right side of the LabScribe Main window
(Figure HC-1-S4). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the iWorx unit and
computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is
turned on and connected to the USB port of the computer. Click OK and select the Find Hardware
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function from the LabScribe Tools menu.
3. Click on the AutoScale button at the upper margin of the Pulse and Blood Pressure channels.

» If the signal on the Pulse channel is upside down when compared to trace in Figure HC-
1-S4, click on the downward arrow to the left of the channel title and select the Invert
function. The trace should now look similar to the one in the figure.

» If the pulse signal is small or noisy, adjust the tension on the strap holding the pulse
plethysmograph to the finger.

4. Record data while the cuff is laying on the table for about 10 seconds.

Select Save As in the File menu, type a name for the file. Choose a destination on the computer
in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click
on the Save button to save the data file.
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Figure HC-1-54: The output of the BP-220 non-invasive blood pressure transducer displayed on the
middle channel of the Main window. Pulse is shown on the top channel and heart rate on the bottom.
Units Conversion

1. Scroll to the beginning of the calibration data for the BP-220 non-invasive blood pressure
transducer.

2. Use the Display Time icons to adjust the Display Time of the Main window to show the 10
second set of data on the Main window at the same time. The required data can also be selected
by:

* Placing the cursors on either side of data required

* Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the
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segment with the four selected pulse cycles to the width of the Main window.

3. Click the 2-Cursor icon (Figure HC-1-S5) so that two blue cursors appear on the Main window.
Place one cursor on the beginning of the flat section of data and the second cursor on the flat
section of data collected approximately 10 seconds later.

4. To convert the voltages at the positions of the cursors to the correct pressure values, use the
Units Offset dialogue window (Figure HC-1-S6 on page HC-1-4). To access this dialogue
window, click on the arrow to the left of the channel title, Blood Pressure, to open the channel
menu. Select Units from the channel menu, and select Set Offset from the Units submenu.
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Figure HC-1-S5: The LabScribe toolbar.

5. On the units conversion window, put a check mark in the box next to Apply units to all blocks.
Enter “0” in the box: Set Mean Value betweeen Cursors to:. Click on the OK button in the
lower right corner of the window to activate the units conversion.
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Figure HC-1-56: The Units Offset dialogue window with the mean values set to “0”.
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Experiment HC-1: Blood Pressure, Peripheral Circulation, and Body Position

Exercise 1: Blood Pressures from the Left Arm

Aim: To determine the systolic and diastolic blood pressures in a reclining subject, and if the subject is
hypotensive (low blood pressure), normotensive, or hypertensive (high blood pressure).

Procedure

1. Instruct the subject to rest in the supine position for at least five minutes before his or her blood
pressure is taken.

2. While the subject is resting, place the blood pressure cuff of the BP-600 around the upper
portion of the left arm, just above the elbow. Place the PT-104 pulse plethysmograph on the
volar surface (where the fingerprints are located) of the distal segment of the left middle finger.
Wrap the Velcro strap around the end of the finger to attach the unit firmly in place.

3. At the end of the rest period, click on the Record button to begin recording the subject’s pulse
and the blood pressure.

4. Inflate the blood pressure cuff until the finger pulse wave on the Pulse channel disappears
(Figure HC-1-L1).

5. Once the pulse wave disappears, release the cuff pressure at the rate of ~10 mmHg/second.
Continue to release the pressure in the cuff until the aneuroid gauge reads 20 mmHg.

6. Click the Stop button. Make sure the blood pressure cuff is completely deflated and is not
putting any unnecessary pressure on the subject's arm.

7. The subject should continue to rest in the supine position between Exercises 1 and 2. To
improve circulation in his or her arm, the subject should flex and extend their fingers to
encourage blood circulation.

8. Select Save in the File menu.

[ %3 5op =00 X

D=d nu.w: HLL&.M:K Defaul View =1 Seqioff =
P | reri=270sme
mmmmm @mem Vvt 045KV
054
Mm MMMMW e
aaaaaaaaaaaa (@@ k) oive @ (AutoScale ) @ (addfunctin =

zzzzzz

2:22.79% 227516 208

Figure HC-1-S1: The pulse wave and the pressure in the cuff of the BP-600 recorded before, during,

and after the occlusion of the brachial artery. Pulses disappeared as the pressure in the cuff exceeded
the pressure in the artery. As the pressure in the cuff is released, the pulse wave reappears.
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Data Analysis

1.

Scroll through the recording and find the section of data recorded before, during, and after the
pressure in the cuff was occluding the pulse.

Use the Display Time icons to adjust the Display Time of the Main window to show the pulse
and the pressure in the cuff of the BP-600 from the occlusion of the artery to the blood pressure
cuff being deflated. This section of data can also be selected by:

* Placing the cursors on either side of the section of data needed.

* Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the
segment of data to the width of the Main window.

Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to
transfer the data displayed in the Main window to the Analysis window.

Look at the Function Table that is above the uppermost channel displayed in the Analysis
window. The mathematical functions that are listed should include V2-V1, Valuel, Value2, and
T2-T1. The values for these parameters from each channel are seen in the table across the top
margin of each channel.

Once the cursors are placed in the correct positions for determining the blood pressures, the
values for the blood pressures can be recorded in the on-line notebook of LabScribe by typing
the names and values directly into the Journal.

The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the parameters from the recording to the Journal. To use these
functions:

* Place the cursors at the locations used to measure the cuff pressures from the Blood
Pressure channel.

* Transfer the name of the mathematical function used to determine the blood pressure to
the Journal using the Add Title to Journal function in the ECG Channel pull-down menu.

* Transfer the value for the blood pressure to the Journal using the Add Ch. Data to
Journal function in the ECG Channel pull-down menu.

. Once the cursors are placed in the correct positions for determining the systolic, diastolic, and

pulse pressures, record the values for these pressures in the Journal using the one of the
techniques described in Steps 5 or 6.

Use the mouse to click on and drag the cursors to specific points on the pulse and blood
pressure recording to measure the following:

* Systolic blood pressure. To determine the subject’s systolic blood pressure, place a
cursor on the first of the smallest pulse waves that reappear after the pressure from the
cuff of the BP-600 is released. Valuel on the Blood Pressure channel is the subject’s
systolic blood pressure. Enter this pressure in Table HC-1-1.2.

* Diastolic blood pressure. To determine the subject’s diastolic blood pressure, place the
other cursor on the first of the largest pulse waves that reappear as the pressure from the
cuff of the BP-600 is released. Value2 on the Blood Pressure channel is the subject’s
diastolic blood pressure. Enter this pressure in the table.
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* Pulse pressure, which is the difference between the systolic and diastolic pressures. To
measure the pulse pressure, leave the cursors on the pulses that occur at the systolic and
diastolic pressures. The value for V2-V1 on the Blood Pressure channel is the subject’s
pulse pressure. Enter this pressure in the table.

9. Determine the subject’s blood pressure class from Table HC-1-L1. List it in Table HC-1-L.2.

Table HC-1-L1: Classification of Blood Pressure Levels According to the Seventh Report of the
Joint National Committee on Prevention, Detection, Evaluation, and Treatment of High Blood
Pressure (JNC 7).

Class Systolic Pressure (mmHg) Diastolic Pressure (mmHg)
Hypotensive 090 060
Normal 0120 and O80
Prehypertensive 120-139 or 80-89
Hypertensive Stage 1 140-159 or 90-99
Hypertensive Stage 2 P160 or P100

Exercise 2: Repeatability of Blood Pressure Measurements

Aim: To determine the repeatability of the blood pressure measurement.from the upper left arm of the
same subject.

Procedure
1. Repeat the procedures outlined in Exercise 1 on the same subject.

2. The subject should continue to rest in the supine position between Exercises 2 and 3.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures of
the subject.

Questions

1. Are the systolic and diastolic blood pressures from Exercises 1 and 2 identical? What are the
possible sources of variation?

2. Since the pressures are determined using changes in the pulse amplitude, would slowing the rate
at which pressure is released from the cuff make your readings more accurate?
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Table HC-1-L2: Blood Pressures from Different Arms in Different Positions

Subject_____ Systolic

Pressure
(mmHg)

Diastolic Pressure Pulse Pressure BP
(mmHg) (mmHg) Class

Cuff Location/Hand
Position

Upper Left Arm/Hand Low,
Ex.1

Upper Left Arm/
Hand Low, Ex.2

Upper Right Arm/
Hand Low

Lower Right Arm
Hand Low

Left Arm/
Left Hand Low

Left Arm/
Right Hand High

Left Arm/
Left Hand High

Warning: If you decide to slow the release from the cuff pressure, remember that restricting
circulation for a prolonged period can be dangerous. Do not release the pressure in the cuff at a rate
any slower than 5 mm Hg per second.

Exercise 3: Blood Pressures from the Right Arm

Aim: To measure blood pressure from the right arm.

Procedure
1. The subject should continue to rest in the supine position before and during this exercise.

2. Place the blood pressure cuff of the BP-600 around the upper portion of the right arm, just
above the elbow. Place the PT-104 pulse plethysmograph on the volar surface of the distal
segment of the right middle finger. Wrap the Velcro strap around the end of the finger to attach
the unit firmly in place.

3. Use the same procedures outlined in Exercise 1 to record the subject’s blood pressures from his
or her upper right arm.

4. The subject should continue to rest in the supine position between Exercises 3 and 4.
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Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures
recorded from the upper right arm of the subject.

Question

Are the values the same as those obtained for the left arm? Explain any differences.

Exercise 4: Blood Pressures from the Forearm

Aim: To examine whether blood pressure declines with distance from the heart.

Procedure
1. The subject should continue to rest in the supine position before and during this exercise.
2. Move the blood pressure cuff from the upper right arm to the lower right arm.
3. Use the same procedures enumerated in Exercise 1 to record the subject’s blood pressures from
his or her lower right arm.
Data Analysis
Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures
recorded from the lower right arm of the subject.
Question

Are the values from the forearm the same as those obtained with the cuff on the upper arm? Explain
any variations that you see.

Exercise 5: Blood Pressures with Different Arm Positions

Aim: To examine the effects of gravity on blood pressure and peripheral circulation.

Procedure

1. Select a new subject and instruct the subject to sit and relax for at least five minutes before his
or her blood pressure is taken.

2. While the subject is relaxing, place the blood pressure cuff of the BP-600 around the upper
portion of the left arm, just above the elbow and the PT-104 on the volar surface of the distal
segment of the left middle finger. Wrap the Velcro strap around the end of the finger to attach
the unit firmly in place.

3. At the end of the relaxation period, use the same procedures used in Exercise 1 to determine the
blood pressures of the subject while the subject is resting both hands in his or her lap.

4. Instruct the subject to place his or her right hand on top of their head. Determine the blood
pressures of the subject while his or her right hand in this position. Instruct the subject to return
his or her hand to their lap after the blood pressures in this position are determined.
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5. Instruct the subject to place his or her left hand on top of their head. Determine the blood
pressures of the subject while his or her left hand in this position. Instruct the subject to return
his or her hand to their lap after the blood pressures in this position are determined.

6. Select Save in the File menu.

7. The subject should continue to sit and relax between Exercises 5 and 6.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures
recorded from the upper left arm of the subject.

Question

What is the effect of raising each hand on the blood pressure in the left arm? Explain your results.

Exercise 6: Blood Pressures from the Leg

Aim: To measure blood pressures from the leg.

Procedure
1. Instruct the subject used in Exercise 5 to sit and relax before his or her blood pressure is taken.

2. While the subject is relaxing, place the blood pressure cuff of the BP-600 around the lower left
leg, just above the ankle, and the PT-104 on the volar surface of the distal segment of the left
large toe. Wrap the Velcro strap around the end of the toe to attach the unit firmly in place.

3. At the end of the relaxation period, use the same procedures used in Exercise 1 to determine the
blood pressures in the subject’s left leg while he or she is sitting with the left foot on the floor.

4. Determine the blood pressures in the subject’s left leg when he or she is:
* reclining in the supine position.

 lifting his or her left leg perpendicular to the bench while reclining; support the leg with
a chair.

* standing.
* standing for three minutes.

5. Select Save in the File menu.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures
recorded from the left leg of the subject.

Questions

1. Are the blood pressure values from the leg the same as those obtained from the arms? Explain
any differences.
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2. What happens to the blood pressures in the subject’s left leg when the subject reclines? When
the subject lifts his or her left leg perpendicular to the bench? When the subject stands? After
the subject has been standing for three minutes?

3. What is happening physiologically to cause the changes discussed in Question 2?

Table HC-1-L3: Blood Pressures from the Left Leg in Different Positions

Subject_____ | Systolic Diastolic Pressure Pulse Pressure
. Pressure (arlal) Crrlsl) BP Class
Leg Position (mmHg)
Sitting
Reclining
Leg Vertical

Standing

Standing 3 Mins
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